testo 6381 · differential pressure transmitter
P2A software · Parameterizing, adjusting and analyzing software

Instruction manual
1 Safety and the environment

Avoiding electrical hazards
> Never use the instrument and connected probes to measure on or near live parts!
> Damaged mains cables must only be replaced by authorized personnel.
> Only have the transmitter wired and connected by authorized personnel with the voltage disconnected.
> You must always comply with the regulations applicable in your country for opening and repairing electrical equipment.

Avoiding personal injury and damage to equipment
> Installation, setting and calibration work must only be carried out by qualified and authorized personnel!
> Only open the instrument when this is expressly described in the instruction manual for installation, maintenance or repair purposes.
> Observe the permissible storage, transport and operating temperature.
> Do not store the product together with solvents. Do not use any desiccants.
> Do not use the instrument for control purposes at the same time as operating or servicing the transmitter.
> Only operate the product properly, for its intended purpose and within the parameters specified in the technical data. Do not use any force.
> Carry out only the maintenance and repair work on this instrument that is described in the documentation. Follow the prescribed steps exactly. Use only original spare parts from Testo.

Any additional work must only be carried out by authorized personnel. Otherwise testo will not accept any responsibility for the proper functioning of the instrument after repair and for the validity of certifications.
Protecting the environment

> At the end of its useful life, send the product to the separate collection for electric and electronic devices (observe local regulations) or return the product to Testo for disposal.

2 About this document

Use

> Please read this documentation through carefully and familiarize yourself with the product before putting it to use. Pay particular attention to the safety instructions and warning advice in order to prevent injuries and damage to the products.

> Keep this document to hand so that you can refer to it when necessary.

> Hand this documentation on to any subsequent users of the product.

⚠️ WARNING
Indicates potential serious injuries

⚠️ CAUTION
Indicates potential minor injuries

Symbols and writing standards

<table>
<thead>
<tr>
<th>Representation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>✉️</td>
<td>Note: Basic or further information.</td>
</tr>
<tr>
<td>1. ...</td>
<td>Action: more steps, the sequence must be followed.</td>
</tr>
<tr>
<td>2. ...</td>
<td></td>
</tr>
<tr>
<td>&gt; ...</td>
<td>Action: a step or an optional step.</td>
</tr>
<tr>
<td>- ...</td>
<td>Result of an action.</td>
</tr>
<tr>
<td>Menu</td>
<td>Elements of the program interface.</td>
</tr>
<tr>
<td>[OK]</td>
<td>Buttons of the program interface.</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>“...”</td>
<td>Example entries</td>
</tr>
</tbody>
</table>
3 Contents

1 Safety and the environment ................................................................. 3

2 About this document ........................................................................... 4

3 Contents ................................................................................................... 5

4 Transmitter ............................................................................................... 8

4.1. Specifications .................................................................................. 8

4.1.1. Functions and use .................................................................................. 8

4.1.2. Scope of delivery .................................................................................. 8

4.1.3. Accessories ...................................................................................... 8

4.1.4. Technical data ................................................................................... 9

4.1.5. Dimensions ..................................................................................... 12

4.2. Product description ........................................................................... 13

4.2.1. At a glance .......................................................................................... 13

4.2.2. Display and keypad ........................................................................... 15

4.2.3. Service interface ............................................................................. 15

4.2.4. Relay board (option) ......................................................................... 15

4.2.5. Analog outputs ................................................................................ 15

4.2.6. Parameters ...................................................................................... 16

4.2.7. Scaling .............................................................................................. 16

4.2.8. Alarm handling ................................................................................ 17

4.3. Commissioning .................................................................................. 18

4.3.1. Assembling the instrument ............................................................... 18

4.3.1.1. Wall mounting ............................................................................... 18

4.3.2. Connecting the instrument ............................................................... 19

4.3.2.1. Overview of terminals .................................................................... 21

4.3.2.2. Connecting voltage supply and analog outputs ................................ 22

4.3.2.3. Connecting the relay outputs ......................................................... 23

4.3.2.4. Plug-in connection option ............................................................. 26

4.3.2.5. Creating the PE/earthing terminal ................................................. 27

4.3.2.6. Closing the instrument ................................................................ 28

4.3.3. Adjusting the instrument ................................................................ 30

4.3.3.1. Analog output adjustment ............................................................. 30

4.3.3.2. n-point adjustment ...................................................................... 31

4.4. Operation ............................................................................................ 32

4.4.1. Relationship between user menu and mini-DIN socket is active ........... 32

4.4.2. Key cover ........................................................................................ 32

4.4.3. Password protection ....................................................................... 33

4.4.4. Structure of user menu ..................................................................... 33

4.4.5. Overview of the testo 6381 user menu ............................................. 35

4.4.6. The individual main menus ............................................................ 38

4.4.6.1. Editing main menu of channel 1 ................................................... 38

4.4.6.2. Editing Main Menu Alarm ............................................................ 39
4.4.6.3. Editing Main Menu Settings .............................................................. 41
4.4.6.4. Editing Main Menu Analysis.............................................................. 43
4.4.6.5. Editing Message main menu............................................................. 45
4.4.6.6. Calling up Main Menu Ident .............................................................. 46
4.4.6.7. Editing Main Menu Adjust ................................................................. 47
4.4.6.8. Editing Reset main menu.................................................................. 48

4.5. Status, warning and error messages .................................................... 48
4.5.1. Status messages ........................................................................................ 49
4.5.2. Warning messages .................................................................................... 50
4.5.3. Transmitter error messages ..................................................................... 51
4.5.4. Handling alarm messages ....................................................................... 51
4.5.5. Namur fault conditions ............................................................................ 52

4.6. Maintenance and cleaning ...................................................................... 53
4.6.1. Maintaining the instrument ..................................................................... 53
4.6.2. Cleaning the instrument .......................................................................... 53

5 Parameterizing, adjusting and analyzing software (P2A software) .. 53
5.1. Specifications............................................................................................... 53
5.1.1. Functions and use ..................................................................................... 54
5.1.2. System requirements .............................................................................. 54
5.1.3. Scope of delivery ...................................................................................... 55
5.2. First steps ...................................................................................................... 55
5.2.1. Installing the software/driver ................................................................. 55
5.2.1.1. Installing P2A software ..................................................................... 55
5.2.1.2. Installing USB driver .................................................................... 55
5.2.1.3. P2A software upgrade .................................................................... 56
5.2.2. Starting the software ............................................................................... 56
5.2.2.1. Starting the program ..................................................................... 56
5.2.2.2. Establishing a connection with the instrument............................... 56
5.2.2.3. Activating the connection with the instrument................................. 56
5.3. Using the software ...................................................................................... 57
5.3.1. User interface .......................................................................................... 57
5.3.2. Editing instrument/parameter file ........................................................... 59
5.3.2.1. Changing instrument/parameter file ............................................... 59
5.3.2.2. Saving parameters .......................................................................... 67
5.3.2.3. Opening the parameter file .............................................................. 68
5.3.2.4. Copying and pasting parameters ..................................................... 68
5.3.2.5. Deleting instrument/parameter file ............................................... 69
5.3.2.6. Creating a new instrument file ......................................................... 69
5.3.3. Analyzing/testing the transmitter ........................................................... 69
5.3.3.1. Analyzing/testing the instrument ..................................................... 69
5.3.3.2. Carrying out factory reset................................................................. 70
5.3.3.3. Testing analog output ..................................................................... 70
5.3.3.4. Testing switch output relays 1 to 4 .................................................. 72
5.3.3.5. Displaying min./max. values .............................................................. 73
5.3.4. Adjusting the transmitter ....................................................................... 74
5.3.4.1. n-point adjustment ........................................................................... 74
5.3.4.2. Adjusting the analog output ............................................................... 75
5.3.5. Transmitter history .............................................................................. 76

6  Tips and assistance .................................................................................. 80
6.1. Questions and answers ......................................................................... 80
6.2. Accessories and spare parts ................................................................. 80
   6.2.1. Ordering options for 6381 transmitter (0555 6381) ........................ 81
4 Transmitter

4.1. Specifications

4.1.1. Functions and use
The testo 6381 transmitter is suitable for the following applications, amongst others:

- Clean rooms
- Drying processes
- Painting systems
- Test benches
- Filling processes
- Monitoring flow velocities or volumetric flow rates in air conditioning systems

4.1.2. Scope of delivery
The scope of delivery of the testo 6381 transmitter includes the following:

- Key cover
- Rear panel bracket
- Instruction manual
- Calibration report
- CD-ROM with operating instructions (PDF), configuration files for Ethernet module and P2A update (this can only be used in conjunction with the P2A software, which has to be ordered separately).

4.1.3. Accessories
The following accessories are available for the testo 6381 transmitter, amongst others:

- Mains unit
- P2A software (parameterizing, adjusting and analyzing software)
- Assembly accessories
Information about accessories and their order numbers can be found in **Accessories and spare parts** or on the website at www.testo.com.

### 4.1.4. Technical data

**Parameters**
- Differential pressure

**Accuracy**

The specifications are only valid if the positive pressure is applied at the positive pressure connection.

- **0.5 %** of measuring range, additional **0.3 Pa** intrinsic error\(^1\)
- **\(T_K\) slope drift** = **0.02 %** of measuring range per degree Kelvin of deviation from nominal temperature **22 °C**
- **\(T_K\) zeroing drift** = **0 %**, as zeroing with solenoid valve\(^2\)

**Measuring range**

<table>
<thead>
<tr>
<th>Pressure measuring range depending on version ordered</th>
<th>Resolution</th>
<th>Overload</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 50 Pa</td>
<td>0.1 Pa</td>
<td>20,000 Pa</td>
</tr>
<tr>
<td>0 to 50 Pa</td>
<td>0.1 Pa</td>
<td>20,000 Pa</td>
</tr>
<tr>
<td>0 to 100 Pa</td>
<td>0.1 Pa</td>
<td>20,000 Pa</td>
</tr>
<tr>
<td>0 to 500 Pa</td>
<td>0.1 Pa</td>
<td>20,000 Pa</td>
</tr>
</tbody>
</table>

\(^1\) Measuring uncertainty in accordance with GUM: ±0.8 % of measuring range final value ±0.3 Pa.

GUM (Guide to the Expression of Uncertainty in Measurement): ISO guideline for determining the measuring uncertainty in order to render global measurement results comparable.

The following uncertainties are used during the inquiry:
- Hysteresis
- Linearity
- Reproducibility
- Adjustment area/factory calibration
- Test location

\(^2\) Minor mixtures of the media may occur at the positive and negative pressure side due to the automatic zeroing cycle.
<table>
<thead>
<tr>
<th>Pressure measuring range depending on version ordered</th>
<th>Resolution</th>
<th>Overload</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 10 hPa</td>
<td>0.01 hPa</td>
<td>200 hPa</td>
</tr>
<tr>
<td>0 to 50 hPa</td>
<td>0.01 hPa</td>
<td>750 hPa</td>
</tr>
<tr>
<td>0 to 100 hPa</td>
<td>0.1 hPa</td>
<td>750 hPa</td>
</tr>
<tr>
<td>0 to 500 hPa</td>
<td>0.1 hPa</td>
<td>2500 hPa</td>
</tr>
<tr>
<td>0 to 1000 hPa</td>
<td>1 hPa</td>
<td>2500 hPa</td>
</tr>
<tr>
<td>-10 to 10 Pa</td>
<td>0.1 Pa</td>
<td>20,000 Pa</td>
</tr>
<tr>
<td>-50 to 50 Pa</td>
<td>0.1 Pa</td>
<td>20,000 Pa</td>
</tr>
<tr>
<td>-100 to 100 Pa</td>
<td>0.1 Pa</td>
<td>20,000 Pa</td>
</tr>
<tr>
<td>-500 to 500 Pa</td>
<td>0.1 Pa</td>
<td>20,000 Pa</td>
</tr>
<tr>
<td>-10 to 10 hPa</td>
<td>0.01 hPa</td>
<td>200 hPa</td>
</tr>
<tr>
<td>-50 to 50 hPa</td>
<td>0.01 hPa</td>
<td>750 hPa</td>
</tr>
<tr>
<td>-100 to 100 hPa</td>
<td>0.1 hPa</td>
<td>750 hPa</td>
</tr>
<tr>
<td>-500 to 500 hPa</td>
<td>0.1 hPa</td>
<td>2500 hPa</td>
</tr>
<tr>
<td>-1000 to 1000 hPa</td>
<td>1 hPa</td>
<td>2500 hPa</td>
</tr>
</tbody>
</table>

Upon delivery and following a factory reset the readings are shown in the display in the unit that was ordered via the KMAT option Fxx, see Ordering options for 6381 transmitter (0555 6381), page 81.

Meas. cycle
- 1/sec

Interface
- Mini-DIN for P2A software (parameterizing and adjusting software) and handheld testo 400/650
- optional: Ethernet module

Voltage supply
- 4-wire (separate signal and supply lines): 20 to 30 V AC/DC, 300 mA power consumption

Maximum load
- 4-wire: 500 Ω (power output)
Maximal load
• 4-wire: 10 kΩ (voltage output)

Analog output
• 0 to 1 V ± 1.5 mV (4-wire) or
• 0 to 5 V ± 7.5 mV (4-wire) or
• 0 to 10 V ± 15 mV (4-wire) or
• 0 to 20 mA ± 0.03 mA (4-wire) or
• 4 to 20 mA ± 0.03 mA (4-wire)

Resolution of analog output
• 12 bit

Relay
• 4 relays, 250 V AC/DC, 3 A (optional)

Display
• 2-line LCD with plain text line (optional)

Operating temperature
• -5 to 50 °C/23 to 122 °F
Storage temperature
-20 to 60 °C/-4 to +140 °F

Process temperature
-20 to 65 °C/-4 to 149 °F

Housing, weight
- Metal, 1.960 kg
- Optional Ethernet module: 0.610 kg

Protection class
- IP 65 only if the transmitter is wired and/or sealing plugs are inserted

Directives, standards and tests

Warranty
- Duration: 2 years
- Warranty conditions: see website www.testo.com/warranty

4.1.5. Dimensions

<table>
<thead>
<tr>
<th>Dimensions in mm</th>
<th>a</th>
<th>b</th>
</tr>
</thead>
<tbody>
<tr>
<td>with M20 cable couplings</td>
<td>144</td>
<td>147</td>
</tr>
<tr>
<td>With NPT cable coupling</td>
<td>144</td>
<td>144</td>
</tr>
<tr>
<td>With M plug-in connection</td>
<td>143</td>
<td></td>
</tr>
</tbody>
</table>
4.2. **Product description**

4.2.1. **At a glance**

1. Keys (only with optional display)
2. Service flap screw connection (self-locking, 2 pcs.)
3. Display (optional)
4. Service flap
5. Negative pressure connection
6. Positive pressure connection, marked with a red washer
7. Lower part of housing
8. M 16 x 1.5 screw connection*, e.g. analog outputs
9. M 16 x 1.5 screw connection*, e.g. voltage supply
10. Earthing/PE connection
11. M 20 x 1.5 screw connection*, e.g. R3 and R4 relays
12. M 20 x 1.5 screw connection*, e.g. R1 and R2 relays
13. Adjusted probe plug (non-functional probe socket)
14. Upper part of housing

* Alternatively, NPT cable couplings or M plug-in connections are available
15 Housing screws

16 Hole for fastening to rear panel bracket (M3 x 6 screw)

17 Plastic bracket for assembly on rear panel
4.2.2. Display and keypad

The display option allows operation of the testo 6381 transmitter via the display and four keys.

The LCD display consists of two 7-segment lines for displaying readings and units and of an information line (for status messages, for example).

The brightness and contrast of the display and the background lighting (permanent or off) can be changed via the user menu or the P2A software.

4.2.3. Service interface

The parameterizing socket (mini-DIN) is located behind the service flap as an interface to the P2A software.

4.2.4. Relay board (option)

This has a floating switch capacity of 250 V AC/3 A. The switching limits and hysteresis as well as the function as relay for the collective alarm can be set via the display or the P2A software.

Further features include:
- Function of changeover contacts (NC/NO contacts) freely selectable
- 12 terminals for a total of 4 relays.

If no relays are available, settings for monitoring limit values or alarms can still be controlled via the display. The alarm status will be shown on the display.

Only have the transmitter wired and connected by authorized personnel with the voltage disconnected.

4.2.5. Analog outputs

As analog outputs, the testo 6381 has either
- 1 current output of 0 to 20 mA (4-wire)/4 to 20 mA (4-wire) or
- 1 voltage output of 0 to 1 V/0 to 5 V/0 to 10 V (4-wire)
4.2.6. **Parameters**

The following parameters are displayed:

- Differential pressure in Pa, hPa, kPa, mbar, bar, mmH₂O, inch H₂O, inch HG, kg/cm², PSI
- Flow in m/s, ft/min
- Volumetric flow rate in m³/h, l/min, Nm³/h, NL/min

4.2.7. **Scaling**

There are three types of min./max. values:

1. The measuring range: The maximum sensor performance is in this range. Values outside of the measuring range are displayed via messages, for example. Measuring range, see table (below).

2. Standard scaling: The output signals are assigned to this measuring range as standard:
   - during delivery if no entries are made in the order code
   - after exchanging the unit, the measuring range recorded in the instrument is applied as standard.
   - The transmitter even retains its scaling with the voltage disconnected.

   Measuring range, see table (below).

3. The maximum settings for the manual scaling
   - The maximum limits can be calculated as follows:
     \[ X = \text{difference between MIN. and MAX. value of the standard scaling} \]
     \[
     (\text{Max. value of standard}) + (50 \% \text{ of } X) \\
     (\text{Min. value of standard}) - (50 \% \text{ of } X)
     \]
   - It is thus possible to scale beyond the measuring range, e.g. for the adjustment of the scaling limits to standard values of a PLC.

---

3 To prevent fluctuating flow rate values at the zero point (depressurized), the flow rate values are only calculated as of differential pressures > 0.2 Pa or > 0.1 % of the respective measuring range (whichever is the greater). With smaller differential pressures, the flow rate value remains at 0.00 m/s.

4 Calculated
With the alarm definition, however, the physical measuring range limits are decisive.

<table>
<thead>
<tr>
<th>Measuring range/standard scaling</th>
<th>Maximum scaling</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 50 Pa</td>
<td>-5 to 15 Pa</td>
</tr>
<tr>
<td>0 to 50 Pa</td>
<td>-25 to 75 Pa</td>
</tr>
<tr>
<td>0 to 100 Pa</td>
<td>-50 to 150 Pa</td>
</tr>
<tr>
<td>0 to 500 Pa</td>
<td>-250 to 750 Pa</td>
</tr>
<tr>
<td>0 to 10 hPa</td>
<td>-5 to 15 hPa</td>
</tr>
<tr>
<td>0 to 50 hPa</td>
<td>-25 to 75 hPa</td>
</tr>
<tr>
<td>0 to 100 hPa</td>
<td>-50 to 150 hPa</td>
</tr>
<tr>
<td>0 to 500 hPa</td>
<td>-250 to 750 hPa</td>
</tr>
<tr>
<td>0 to 1000 hPa</td>
<td>500 to 1500 hPa</td>
</tr>
<tr>
<td>-10 to 10 Pa</td>
<td>-20 to 20 Pa</td>
</tr>
<tr>
<td>-50 to 50 Pa</td>
<td>-100 to 100 Pa</td>
</tr>
<tr>
<td>-100 to 100 Pa</td>
<td>-200 to 200 Pa</td>
</tr>
<tr>
<td>-500 to 500 Pa</td>
<td>-1000 to 1000 Pa</td>
</tr>
<tr>
<td>-10 to 10 hPa</td>
<td>-20 to 20 hPa</td>
</tr>
<tr>
<td>-50 to 50 hPa</td>
<td>-100 to 100 hPa</td>
</tr>
<tr>
<td>-100 to 100 hPa</td>
<td>-200 to 200 hPa</td>
</tr>
<tr>
<td>-500 to 500 hPa</td>
<td>-1000 to 1000 hPa</td>
</tr>
<tr>
<td>-1000 to 1000 hPa</td>
<td>-2000 to 2000 hPa</td>
</tr>
</tbody>
</table>

### 4.2.8. Alarm handling

For upper and lower alarm limits, individual alarms as well as collective alarms can be specified. If the collective alarm function is activated, an alarm is triggered as soon as the alarm limit of an alarm is exceeded, if this alarm is assigned to the collective alarm.

The testo 6381 monitors limit values with the help of relays. If a reading is outside the limit values, a relay to be specified by the user is switched.

If the reading reverts to more than a specified hysteresis below or above the limit value, the alarm is cancelled.
In addition, information about the occurrence of error/status messages can be provided by means of a collective alarm relay, see Status, warning and error messages, page 48

If multiple alarm messages are activated at the same time, the last alarm is shown. If the alarm is cancelled again, the previous messages are no longer shown.

4.3. Commissioning

4.3.1. Assembling the instrument

4.3.1.1. Wall mounting

Attaching rear panel bracket

1. Remove locking screw (see item (4) of drawing below) and detach rear panel bracket from plastic bracket (see item (2) of drawing below).
2. Hold rear panel bracket in assembly position and mark the three drill holes.
3. Drill three holes (Ø 5 mm) and insert dowels where necessary.
4. Screw on rear panel bracket.
   Remember that the clamping brackets (1) must face the wall.
Fastening instrument to rear panel bracket

1. Slide plastic bracket (2) on the back of instrument onto rear panel bracket until it engages (see arrows).
2. Insert screw (4) through hole (3) and screw into rear panel bracket.

4.3.2. Connecting the instrument

Opening the instrument

1. Loosen screw connection (1) of service flap and open the flap.
2. Loosen and remove housing screws (2).
3. Remove upper part of housing from lower part (3) and place on a clean surface.

**WARNING**

**Electrical voltage**

**Danger of injury!**

> De-energize the mains connection before connecting the transmitter.

Only have the transmitter wired and connected by authorized personnel with the voltage disconnected.
4.3.2.1. Overview of terminals

1 Lower part of housing
2 Relay board (option)
3 Relay terminals
4 Insulating trough for relay board
5 Terminal strip for voltage supply and analog outputs
6 Terminal board
7 Earthing terminal (internal)
8 M 16 x 1.5 screw connection*
9 Earthing terminal (external)
10 M 20 x 1.5 screw connection*
11 Eyelet for measuring point panel

* Alternatively, NPT cable coupling or M plug-in connection

The following description of the terminals refer to this overview and its numbering.
4.3.2.2. Connecting voltage supply and analog outputs

Channels 2 and 3 shown on the circuit board cannot be used with this instrument.

1. Feed cable with voltage supply and analog signal lines through opened M 16 x 1.5 screw connection (item (8) in the overview of terminals).
2. Strip the cable ends, clamp wire end ferrules on and screw down onto voltage terminals.
3. Close M 16 x 1.5 screw connection (item (8) in the overview of terminals).

Wiring diagram for 4-wire system (0 to 20 mA/4 to 20 mA/0 to 1 V/0 to 5 V/0 to 10 V)

Channels 2 and 3 shown on the circuit board cannot be used with this instrument.
Requirement for the connecting cable of the supply:

- Insulated with cross-section of at least 0.25 mm², maximum 2.7 mm² without wire end sleeves.
- The supply line must be secured against exceeding 8 A.
- An OFF switch must be installed in an easily accessible position close by and be marked as such.

1. Feed connection cable of the channel through opened M 16 x 1.5 screw connection (item (8) in the overview of terminals).
2. Strip the cable ends, clamp wire end ferrules on and screw to channel terminals as shown in diagram.
3. Close M 16 x 1.5 screw connection (item (8) in the overview of terminals).

4.3.2.3. Connecting the relay outputs

Only have the transmitter wired and connected by authorized personnel with the voltage disconnected.

There is the option of twelve terminals for a total of four relays. The designations NC/C/NO (normally closed contact/root or pin/normally open contact) are etched on the surface of the board.

Using PG screw connection

1. Feed connection cables for the relays through opened M 20 x 1.5 screw connection (item (10) of overview of terminals).
2. Strip cable ends and clamp on wire end ferrules.
3. Connect relays according to chosen function (NC/NO) (see diagrams below; relay 1 is shown as an example of a connection).

Using plug-in connections (optional)

Only insert or disconnect the plug-in connection when the voltage is disconnected.

4. Clean the connector of the probe line and the coupling of any foreign matter.
Do not disconnect the connector of the probe line from the instrument for extended periods to protect against contamination.

Connection note

- For the connection, a double-insulated mains cable (sheathed cable) with a cross-section of at least 1.5 mm² must be used.
- Cable connection (2) may not be routed in a loop within the tray (1).
- It is recommended that you always tie 3 cores to one another using a cable tie (3).
- The insulation of the cable must be fed at least 5 mm (4) into the tray.
Use of relay as NC contact (NC = normally closed)

1. Alarm/status light (example of installation)
2. 250 V AC/DC, 3 A

The busy light (alarm/status light) is permanently on until the relay opens or the circuit is interrupted. This circuit can therefore be used to monitor the functionality of the alarm circuit, as a cable break, for instance, is indicated by the busy light going off.

Use of relay as NO contact (NO = normally open)

1. Alarm/status light (example of installation)
2. 250 V AC/DC, 3 A
The busy light (alarm/status light) only comes on when the relay is switched (closed). Monitoring the functionality of the alarm circuit is therefore not possible with this switching operation.

5. Close M 20 x 1.5 screw connection (item (9) in overview of terminals).

4.3.2.4. Plug-in connection option

As an option, the PG screw connections of the signal and supply lines can be replaced with plug-in connections that are installed at the housing, see item 1 and 2. The relay cabling occurs via standard cable entries and PG screw connections, see item 3 and 4.

<table>
<thead>
<tr>
<th>PIN</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>V 24-</td>
</tr>
<tr>
<td>2</td>
<td>V 24+</td>
</tr>
<tr>
<td>3</td>
<td>+ Ch1</td>
</tr>
<tr>
<td>4</td>
<td>- Ch1</td>
</tr>
<tr>
<td>5</td>
<td>PE</td>
</tr>
</tbody>
</table>

Plug-in connections for power supply and channels

M12 plug-in connection (5-pin) socket (item 1)

View of the plug-in connections in the installed state from outside
4.3.2.5. Creating the PE/earthing terminal

As the testo 6381 has a metal housing, we recommend that the instrument be earthed. This can be done using the earthing terminal within the instrument (1) or the earthing terminal outside of the instrument (2).

Only use the external earthing terminal in dry interiors.

Using the earthing terminal within the instrument
1. Guide shielded cable (5) through the cable coupling (x) and fit cable lug (8). Fix this to the side of the instrument (6) using M 5 screw (3), washer (4) and snap ring (7) on the internal earthing terminal (1).
2. Place the other cable end on an appropriate functional earth, e.g. an earthing bar.

Using an earthing terminal outside of the instrument
1. Use PE line (yellow-green) (5) with cable lug (8). Fix this using M 5 screw (3), washer (4) and snap ring (7) on the external earthing terminal (2).
2. Place the other cable end on an appropriate functional earth, e.g. an earthing bar.
4.3.2.6. Closing the instrument

1. Place upper part of instrument on top of lower part (see arrow) and fix in place with housing screws (1).
2. Close the service flap and tighten screws (2).
4.3.3. **Adjusting the instrument**

4.3.3.1. **Analog output adjustment**

The purpose of adjusting the analog outputs is to adjust the signal chain from the digital signal (within the transmitter) to the analog outputs. The signal type that was appointed for the transmitter is adjusted respectively for each channel (e.g. 4 to 20 mA or 0 to 1 V, etc.).

Adjusting analog output 1

✓ With testo 6381 with current output: Load of max. 500Ω is connected to channel 1 (see Plug-in connections for power supply and channels, page 26)

✓ A precise multimeter (minimum requirement: resolution 6.5 digits, at least 5-times more accurate than the 6381) is available.

If only a simple multimeter is available, the analog output must not be adjusted.

✓ The service flap is open.

1. Connect the inputs of the multimeter with the contacts (2) and (3) for channel 1.
2. Transfer the reference analog value measured with the multimeter into the P2A software (see Adjusting the analog output, page 75) or enter it via the user menu (see Performing analog adjustment, page 47).

3. Disconnect connections between the multimeter and the contacts of the testo 6381 and close the service flap.

### 4.3.3.2. n-point adjustment

With an n-point adjustment, the parameters at the 3-6 measurement points are adjusted to the reference value. The reference conditions are obtained by using a precise pressure sensor that should be 5-times more accurate than the transmitter.

1. Positive pressure connection
2. Negative pressure connection
3. Pressure sensor

---

The number of measuring points is set to 3 by the factory and can only be changed using the P2A software (see **n-point adjustment**, page 74).

The n-point adjustment must always be carried out to its full extent and in good time at all selected measurement points.

✓ A precise pressure sensor (5-times more accurate than the transmitter, e.g. DPC precision pressure sensor from testo industrial services) is available.

1. Connect the positive output of the pressure sensor (3) to the positive pressure connection of the transmitter (1) and the negative output of the pressure sensor (3) to the negative pressure connection of the transmitter (2).

2. Transfer the reference pressure value created with the pressure sensor into the P2A software (see n-point adjustment, page 74) or enter it via the user menu (see Performing analog adjustment, page 47).

3. Repeat step 2 for all of the measuring points.

4. Disconnect connections between the pressure sensor and the pressure connections of the testo 6381.
4.4. Operation

4.4.1. Relationship between user menu and mini-DIN socket is active

The testo 6381 can be parameterized using either the user menu or the P2A software (see Parameterizing, adjusting and analyzing software (P2A software) page 53).

The testo 6381 transmitter can only be operated via the display and keypad if the display option is available.

If the testo 6381 is connected to the P2A software, the user menu is blocked for the duration of the communication. The message Service plug is shown in the display of the testo 6381. As soon as the P2A software is disconnected, the user menu is accessible again.

4.4.2. Key cover

To prevent unauthorized operation of the keys, the standard key frame can be replaced with a key cover.

If the key cover has been assembled, the service flap must be opened for operation.
Attaching the key cover

✓ The service flap is opened, see Opening the instrument, page 19.

1. Unscrew screws (3) and remove key frame (2).
2. Insert key cover (1) into service flap and tighten screws (3).
3. Close and screw down the service flap.

4.4.3. Password protection

The user menu can be protected with a four-digit numerical code (see Editing Main Menu Settings, page 41) so that access to the user menu is denied to unauthorized persons not familiar with this numerical code.

If the password protection is not to be used, the numerical code "0000" must be entered. This is also the status upon delivery.

4.4.4. Structure of user menu

At the main menu level, the user menu comprises the following:

• Main Menu Channel 1
• Main Menu Alarm
• Main Menu Settings
Four keys enable the user to navigate/scroll through the menus and enter/amend values and settings:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function/description</th>
</tr>
</thead>
</table>
| SET | • In Measuring Mode: changes to parameterization  
     • In Parameterizing Mode: confirms a selection or setting |
| ESC | • Leaves a menu (without modifying any settings) |
| ▼   | • Selecting: scrolls through menus (downwards) or selectable alternatives  
     • Editing: changes to next digit (to the right) |
| ▲   | • Selecting: scrolls through menus (upwards) or selectable alternatives  
     • Editing: increases the value of the current digit by 1 |
4.4.5. Overview of the testo 6381 user menu

Password (enter where necessary)

Measuring →

Channel 1
- Change Limit 1
  - Min scale channel 1
    - Edit
  - Max scale channel 1
    - Edit
  - Attenuation channel 1
    - Selection

Alarm
- Alarm 1
  - Not used
  - Channel 1
    - Min control
      - Limit
        - Edit
      - Hysteresis
        - Edit
      - Alarm delay
        - Edit
      - Optical alarm
        - Selection
      - See Min control

Collective alarm
- Optical alarm
  - Selection

Alarm 2, 4
- See alarm 1
4.4.6. The individual main menus

4.4.6.1. Editing main menu of channel 1

An overview is given in Overview of the testo 6381 user menu, page 35).

You can perform basic settings for channel 1.

1. In the Measuring Mode press SET, select Main Menu Channel 1 with ▶ or ▲ and confirm selection with SET.

   One of the following parameters can now be selected using ▶ or ▲, after which the selection must be confirmed with SET:

   • Channel 1 Unit
     The parameter for this channel is selected.
     Edit/select parameter with ▶ or ▲, confirm with SET or abort entry with ESC.

   • Scale minimum for channel 1:
     The lower scale limit is edited; Unit as selected above.
     Editing the value: Scroll one digit to the right using ▶ and increase value of digit by 1 using ▲. Confirm with SET or abort entry with ESC.

   • Scale maximum for channel 1
     The upper scale limit is edited;
     Unit as selected above.
     Editing the value: Scroll one digit to the right using ▶ and increase value of digit by 1 using ▲. Confirm with SET or abort entry with ESC.

   • Signal delay ("Attenuation") for channel 1
     The analog signal can be delayed ("Attenuation"); a time constant is selected for this (1 = no delay; 15 = longest delay)
     Edit/select parameter with ▶ or ▲, confirm with SET or abort entry with ESC.

2. Continue to the main menu with ▶ or ▲ or return to Measuring Mode with ESC.
4.4.6.2. Editing Main Menu Alarm

With the alarm, the relays, available as options, are programmed. In addition, the alarm statuses are shown on the display (top right) (even without relays).

You can choose whether the alarm is to be used to monitor limit values or as a collective alarm. If an alarm is to be used to monitor limit values, you can choose between monitoring the minimum or maximum value and set a limit value and hysteresis for each alarm.

In addition, every alarm can be linked to a clearly visible visual alarm (display background lighting flashes).

An alarm delay between 0 and 240 seconds can still be assigned to every alarm used for limit value monitoring so that both the corresponding relay effect and the visual alarm are delayed. If the alarm status goes out within the set alarm delay time, neither the visual alarm nor a relay connection is triggered.

With an alarm status present, the visual alarm and all relay outputs can be reset by means of acknowledgement. The triggering of a new alarm cannot be enabled until after the alarm status goes out.

1. In the Measuring Mode press SET, select Main Menu Alarm with ▶ or ▲ and confirm selection with SET.

- Four alarms can be parameterized.

2. Select Alarm x with ▶ or ▲ and confirm selection with SET.

Using alarm to monitor limit values

**NO contact**

<table>
<thead>
<tr>
<th>Monitoring minimum</th>
<th>Monitoring maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hysteresis On</td>
<td>Hysteresis Off</td>
</tr>
<tr>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td>Limit value</td>
<td>Limit value</td>
</tr>
</tbody>
</table>

**NC contact**

<table>
<thead>
<tr>
<th>Monitoring minimum</th>
<th>Monitoring maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hysteresis Off</td>
<td>Hysteresis On</td>
</tr>
<tr>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>Limit value</td>
<td>Limit value</td>
</tr>
</tbody>
</table>
3. Select **Channel x** (e.g. "Channel 1") with ▶ or ▲ and confirm selection with SET.

4. Select **Max control** or **Min control** with ▶ or ▲ (see graphic).

5. Press SET and edit **Limit value** as well as **Hysteresis**: Scroll one digit to the right using ▶ and increase value of digit by 1 using ▲. Confirm with SET or abort entry with ESC.

6. Select **Visual alarm** with ▶ or ▲. Select YES or NO with ▶ or ▲. Confirm with SET or abort entry with ESC.

7. Press SET and edit **Alarm delay**: Scroll one digit to the right using ▶ and increase value of digit by 1 using ▲ (0 to 240 seconds possible). Confirm with SET or abort entry with ESC.

8. Return to **Channel x** with ESC.

9. Return to **Alarm x** with ESC.

10. Change to the other relays using ▶ or ▲ and perform settings in the same way.

**Using alarm as collective alarm or not using it at all**

If an alarm is assigned to the collective alarm, the relay is switched and a visual alarm can be issued via the display as soon as (at least) one of the warning or error messages of the testo 6381 transmitter becomes active.

---

The messages affecting the collective alarm can only be selected in the P2A software, see Using the software, page 57

---

✓ Alarm is selected (see previous steps 1 and 2).

1. Use ▶ or ▲ to determine whether **Alarm x** should be used as a **Collective alarm** or **not used**. Confirm selection with SET.

2. If collective alarm is selected: Select **Visual alarm** with ▶ or ▲. Select YES or NO with ▶ or ▲. Confirm with SET and return to **Alarm x**.

3. Change to another alarm using ▶ or ▲ and perform settings in the same way.

4. Return to **Main Menu Alarm** with ESC.

5. Continue to **Main Menu Settings** with ▶ or ▲ or return to Measuring Mode with ESC.
4.4.6.3. **Editing Main Menu Settings**

You can edit instrument settings and other settings.

> In Measuring Mode, press SET, select **Main Menu Settings** using ▶ or ▲ and confirm selection with SET.

You can edit settings for:
- Display
- Language
- Code
- Units
  - Absolute pressure
  - Area
  - Temperature
  - Standard data
  - Process data

**Editing display settings**

You can set the brightness and contrast of the display.

1. Select **Display Settings** with ▶ or ▲ and confirm selection with SET.
2. Select **Backlight** or **Contrast** with ▶ or ▲ and confirm selection with SET.

One of the following parameters can now be selected using ▶ or ▲, after which the selection must be confirmed with SET:

- **Backlight**
  The display illumination is changed.
  Edit/select parameter with ▶ or ▲, confirm with SET or cancel entry with ESC (the effect of the change in parameter can be seen during input).

- **Contrast**
  The brightness difference between the display background and the displayed values is changed.
  Edit/select parameter with ▶ or ▲, confirm with SET or cancel entry with ESC (the effect of the change in parameter can be seen during input).

- **Backlight 24h on**
  Select On or Off using ▶ or ▲ and confirm with SET.
Off: The display light switches off automatically if no button was pressed for 10 seconds.

On: The display light is activated

3. Return to Display Settings with ESC and use or ▲ to continue to Language.

Selecting language

You can select the language for the plain text line in the display.

> Press SET, select required language with ▶ or ▲, confirm selection with SET and return to Language.

Only choose a language that you can understand well.

Select unit

This setting affects the unit of the standard and process data.

1. Press SET, select Change parameters with ▶ or ▲, confirm selection with SET or cancel with ESC.

2. Select Change unit with ▶ or ▲, confirm selection with SET or cancel with ESC.

3. Select the required variable (absolute pressure/area/temperature) with ▶ or ▲, confirm selection with SET or cancel with ESC.

4. Select the required unit with ▶ or ▲, confirm selection with SET or cancel with ESC.

5. Return to Change unit with ESC and continue to Standard data with ▶ or ▲.

Editing standard data

Setting individual values for the standard data to calculate the volumetric flow rate.

1. Select Standard data with ▶ or ▲, confirm selection with SET or cancel with ESC.

2. Select the required variable (absolute pressure/temperature) with ▶ or ▲, confirm selection with SET or cancel with ESC.

3. Scroll one digit to the right using ▶ and increase value of digit by 1 using ▲. Confirm with SET or abort entry with ESC.

4. Return to Standard data with ESC and use ▶ or ▲ to continue to Pressure process data.
Editing pressure process data
Setting of the process data for the Pitot tube calculation.

1. Select **Pressure process data** with ▶ or ▲ and confirm selection with **SET**.
2. Select the required variable (absolute pressure/humidity/temperature/cross-section/Pitot tube factor/correction factor) with ▶ or ▲, confirm selection with **SET** or cancel with **ESC**.
3. Scroll one digit to the right using ▶ and increase value of digit by 1 using ▲. Confirm with **SET** or abort entry with **ESC**.
4. Return to **Pressure process data** with **ESC**.
5. Return to **Change parameters** with **ESC** and use ▶ or ▲ to continue to **Code**.

Editing code settings
You can set the access code (password).

- If a code other than "0000" (factory setting) is set, the transmitter can only be operated once this code has been entered via the menu.

1. Select **Code** with ▶ or ▲ and confirm selection with **SET**.
2. Scroll one digit to the right using ▶ and increase value of digit by 1 using ▲. Confirm with **SET** or abort entry with **ESC**.
3. Return to **Code** with **ESC**.
4. Return to **Main Menu Settings** with **ESC**.

4.4.6.4. Editing Main Menu Analysis
You can test the functionality of analog and relay outputs. In addition, you can read off the minimum and maximum values (since the last voltage supply or reset of the min./max. values).

Testing functionality of analog outputs

- This function affects the analog outputs directly, not only the test contacts.

1. In the Measuring Mode press **SET**, select **Main Menu Analysis** with ▶ or ▲ and confirm selection with **SET**.
   - **Test Analog Output** is shown.
2. Press **SET**, scroll one digit to the right using ▶ and increase value of digit by 1 using ▲. Any analog output value can be...
predefined, e.g. for an analog output of 4 to 20 mA, the value "6.0 mA". Confirm with SET or abort entry with ESC.

3. Accept setting by pressing SET and test with multimeter (minimum requirement: resolution 6.5 digits, at least 2-times more accurate than the 6381) as follows:

Analog output 1: Via test contacts under service flap, see diagram.

4. Return to Test Analog Output with ESC and use ‒ or ▲ to continue to Test Relay Output.

Testing functionality of the pressure sensor (Test pressure sensor)

This function is only required to calibrate the pressure sensor.

Testing functionality of relay outputs

1. Press SET and choose between Alarm 1, 2, 3, 4 with ‒ or ▲.

2. Press SET.

The relay can now be tested. You can choose between OFF and ON using ‒ or ▲. If ON is chosen, the NO contact is closed, the NC contact opened. If OFF is chosen, the NC contact is closed, the NO contact opened.

3. To test, route a measuring cable from the relay terminals (see Connecting the relay outputs, page 23) out of the transmitter to a multimeter (resistance measurement) or continuity tester.

4. Return to Test Relay Output with SET (starts relay test) or ESC (exits the menu without relay test).
Reading off min./max. values of channels
To reset the max./min. values, see Editing Reset main menu, page 48

1. Read off the min./max. values of the channel in succession with ▶ or ▲ and return to the Main Menu Analysis with ESC.
2. Continue to Main Menu Message with ▶ or ▲ or return to Measuring Mode with ESC.

4.4.6.5. Editing Message main menu
Messages can be confirmed/acknowledged, the last messages can be called up and the display of the messages can be switched on or off.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating hours at the time of message</td>
<td>Message code (see Status, warning and error messages, page 48).</td>
<td>Message text</td>
<td>Message number (example: &quot;4/7&quot; refers to the fourth of seven messages)</td>
<td>Number of messages present (example: &quot;4/7&quot; refers to the fourth of seven messages)</td>
</tr>
</tbody>
</table>

Using the P2A software (see Parameterizing, adjusting and analyzing software (P2A software), page 53) you can predefine whether messages are to be shown in the display.

1. In the Measuring Mode press SET, select Main Menu Message with ▶ or ▲ and confirm selection with SET.
2. Confirm Confirm message using SET.
3. Select Last messages with ▶ or ▲ and confirm with SET.
4. Scroll between the warning and error messages recorded so far using ▶ or ▲ and return to Last messages using ESC.
5. Select Information with ▶ or ▲ and confirm with SET.
6. Scroll between the status messages recorded so far using ▶ or ▲ and return to Information using ESC.
7. Continue to **Display of message** with ▶ or ▲.
   - **ON**: Measurements are shown on the display in Measuring Mode.
   - **OFF**: No messages shown on display.

8. Select **ON** or **OFF** with ▶ or ▲ and confirm selection with **SET**.

9. Return to **Main Menu Message** with **ESC**.

10. Continue to **Main Menu Ident** with ▶ or ▲ or return to Measuring Mode with **ESC**.

---

An overview of the messages can be found in Status, warning and error messages, page 48

---

### 4.4.6.6. Calling up Main Menu Ident

![Diagram of display showing instrument type, build number, firmware version, and serial number.]

<table>
<thead>
<tr>
<th>Position</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Instrument type</td>
</tr>
<tr>
<td>2</td>
<td>Build number</td>
</tr>
<tr>
<td>3</td>
<td>Firmware version</td>
</tr>
<tr>
<td>4</td>
<td>Serial number</td>
</tr>
</tbody>
</table>

Serial 1111111

1. In the Measuring Mode press **SET**, select **Main Menu Ident** with ▶ or ▲ and confirm selection with **SET**.
   - The type, firmware version, build number and serial number of the transmitter are displayed.

   This information is required when servicing.

2. Return to **Main Menu Ident** with **ESC**.

3. Continue to **Main Menu Adjust** with ▶ or ▲ or return to Measuring Mode with **ESC**.
4.4.6.7. Editing Main Menu Adjust

Also see Analog output adjustment, page 30, for instructions on how to perform the analog adjustment.

Performing analog adjustment

1. In the Measuring Mode press SET, select main menu Adjust with ▶ or ▲ and confirm selection with SET.

   Each channel is adjusted at three points in the analog range (at 10%; 50%; 90% of the analog scale).

2. Select Analog Adj. Ch. 1 with ▶ or ▲ and confirm with SET.
3. Use ▶ or ▲ to select Adj. Point 1.
4. Press SET. Read off multimeter display and enter this value in the user menu. Do this by scrolling one digit to the right using ▶ and increasing the value of digit by 1 using ▲. Confirm with SET or abort entry with ESC.
5. Use ▶ or ▲ to select Adj. Point 2.
6. Press SET. Read off multimeter display and enter this value in the user menu. Do this by scrolling one digit to the right using ▲ and increasing the value of digit by 1 using ▶. Confirm with SET or abort entry with ESC.
7. Use ▶ or ▲ to select Adj. Point 3.
8. Press SET. Read off multimeter display and enter this value in the user menu. Do this by scrolling one digit to the right using ▲ and increasing the value of digit by 1 using ▶. Confirm with SET or abort entry with ESC.
9. Return to main menu Adjust with ESC.
10. Continue to main menu Reset with ▶ or ▲ or return to Measuring Mode with ESC.

Performing the pressure adjustment

Also see n-point adjustment, page 31, for instructions on how to perform the pressure adjustment.

1. In the Measuring Mode press SET, select main menu Adjust with ▶ or ▲ and confirm selection with SET.

   The pressure adjustment can be performed at 3 to 6 adjustment points.

2. Select Adjust Pressure with ▶ or ▲ and confirm with SET.
3. Use ▶ or ▲ to select Adj. Point 1.
4. Press **SET**. Read off pressure sensor display and enter this value in the user menu. Do this by scrolling one digit to the right using ▶ and increasing the value of digit by 1 using ▲. Confirm with **SET** or abort entry with **ESC**.

5. Repeat steps 1 to 4 for adjustment points 2 to 6.

6. Return to main menu **Adjust** with **ESC**.

7. Continue to main menu **Reset** with ▶ or ▲ or return to Measuring Mode with **ESC**.

**4.4.6.8. Editing Reset main menu**

You can reset the factory settings for the following:

- Instrument
- Min./max. values

Resetting to the factory settings means resetting to the order specification, i.e. the specific condition at the time of supply to the customer.

1. In the Measuring Mode press **SET**, select **Main Menu Reset** with ▶ or ▲ and confirm selection with **SET**.

   - **Reset Device** to factory settings is displayed.

2. Select the setting to be reset using ▶ or ▲ and confirm selection with **SET**.

   - **Reset Completed** is displayed.

3. Return to the reset setting with **ESC** or **SET** and return to **Main Menu Reset** with **ESC**.

4. Continue to the **Main Menu Channel 1** with ▶ or ▲ or return to Measuring Mode with **ESC**.

**4.5. Status, warning and error messages**

To achieve optimum operational reliability (machine availability), the transmitter shows the following via the user menu or the P2A software:

- Status messages
- Warning messages
- Error messages

in each case for the testo 6381 transmitter.

All messages are stored in the transmitter with an operating hours stamp. Use the user menu (see Editing Message main menu, page
4 Transmitter

45) or the P2A software (see Transmitter history, page 76) to view the message history.

In the transmitter, the last 60 status messages and the last 120 error and warning messages are stored in a ring memory. There is no limit in the P2A software.

4.5.1. Status messages

Status messages show the current operating status of the testo 6381.

<table>
<thead>
<tr>
<th>Message</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>02506</td>
<td>Sensor initialization</td>
<td>Message appears while the transmitter is starting up. If the message disappears, the transmitter is ready for operation.</td>
</tr>
<tr>
<td>01D19</td>
<td>Service plug</td>
<td>The Mini-DIN socket is connected to: the USB adapter for P2A software, the adjustment adapter or the service plug (is not recorded/no number)</td>
</tr>
<tr>
<td>00300</td>
<td>New limit value</td>
<td>The limit value has been changed or shifted</td>
</tr>
<tr>
<td>00301</td>
<td>Scaling changed</td>
<td>The scaling has been changed</td>
</tr>
<tr>
<td>00117</td>
<td>Adjustment DeltaP</td>
<td>An n-point adjustment was performed.</td>
</tr>
<tr>
<td>02104</td>
<td>Analog adjustment</td>
<td>An analog adjustment has been made</td>
</tr>
<tr>
<td>00530</td>
<td>Change solenoid valve</td>
<td>The solenoid valve should be changed</td>
</tr>
<tr>
<td>00500</td>
<td>Transmitter reset</td>
<td>The transmitter was reset to the factory settings and is restarted.</td>
</tr>
<tr>
<td>0052F</td>
<td>Reset Min/Max</td>
<td>Resets all saved Min/Max values for all channels</td>
</tr>
<tr>
<td>00503</td>
<td>Reset device to fact</td>
<td>A factory reset of the transmitter was performed</td>
</tr>
<tr>
<td>00307</td>
<td>User Setting Change</td>
<td>User Setting Change: General settings were changed for the transmitter.</td>
</tr>
</tbody>
</table>
### 4.5.2. Warning messages

Warning messages show an early warning or a current malfunction which may negatively impact measuring.

<table>
<thead>
<tr>
<th>Message</th>
<th>Display</th>
<th>Cause</th>
<th>Remedying of fault</th>
</tr>
</thead>
<tbody>
<tr>
<td>00E00</td>
<td>T ambient high</td>
<td>The ambient temperature exceeds the permissible temperature for the transmitter</td>
<td>Take necessary measures to lower ambient temperature, e.g. through venting or cooling</td>
</tr>
<tr>
<td>00E01</td>
<td>T ambient low</td>
<td>The ambient temperature is below the permissible temperature for the transmitter</td>
<td>Take necessary measures to raise ambient temperature, e.g. through heating</td>
</tr>
<tr>
<td>00809</td>
<td>Pressure too high</td>
<td>The process pressure exceeds the pressure intended for the transmitter</td>
<td>Remove the transmitter from the process and take any necessary measures to lower the pressure</td>
</tr>
<tr>
<td>00E02/00E05</td>
<td>Supply voltage low</td>
<td>The supply voltage is below the minimum voltage required for the transmitter</td>
<td>Take measures to ensure sufficient voltage supply</td>
</tr>
<tr>
<td>0081C</td>
<td>Alarm 1</td>
<td>Depending on the parameterization of the relay</td>
<td>Depending on the parameterization of the relay</td>
</tr>
<tr>
<td>0081D</td>
<td>Alarm 2</td>
<td>Depending on the parameterization of the relay</td>
<td>Depending on the parameterization of the relay</td>
</tr>
<tr>
<td>0081E</td>
<td>Alarm 3</td>
<td>Depending on the parameterization of the relay</td>
<td>Depending on the parameterization of the relay</td>
</tr>
<tr>
<td>0081F</td>
<td>Alarm 4</td>
<td>Depending on the parameterization of the relay</td>
<td>Depending on the parameterization of the relay</td>
</tr>
</tbody>
</table>
4.5.3. **Transmitter error messages**

Error messages show a current malfunction.

<table>
<thead>
<tr>
<th>Message</th>
<th>Display</th>
<th>Cause</th>
<th>Remedying of fault</th>
</tr>
</thead>
<tbody>
<tr>
<td>01505</td>
<td>Watchdog error</td>
<td>Due to a processor error, the transmitter performs an automatic restart.</td>
<td>If the problem occurs frequently, contact Testo Service.</td>
</tr>
<tr>
<td>01115</td>
<td>Low adjustment temperature</td>
<td>The ambient temperature is too low during the pressure adjustment.</td>
<td>Take necessary measures to raise ambient temperature, e.g. through heating.</td>
</tr>
<tr>
<td>01116</td>
<td>High adjustment temperature</td>
<td>The ambient temperature is too high during the pressure adjustment.</td>
<td>Take necessary measures to lower ambient temperature, e.g. through venting.</td>
</tr>
</tbody>
</table>

4.5.4. **Handling alarm messages**

<table>
<thead>
<tr>
<th>Shown on the display</th>
<th>Can be used for collective alarm</th>
<th>Additional message end</th>
</tr>
</thead>
<tbody>
<tr>
<td>New limit value</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Scaling changed</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Adjustment DeltaP</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Pressure too high</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Alarm 1</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Alarm 2</td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

5 If multiple messages/alarms are activated at the same time, only the last message/alarm is shown. If this is cancelled, the other messages that are still active are no longer displayed.

6 The message can be assigned the collective alarm function, which means that the collective alarm is activated as soon as at least one of the messages assigned to it is activated. The collective alarm can be assigned to each of the 4 optional relays. The collective alarm is then always the same, as it can only be defined once.

7 The message is shown upon the occurrence of the event causing the message as well as when closing. Two entries appear in the history in the P2A software: Message text_start and Message text_end.
### Namur fault conditions

If the faults named in the following table occur, the analog outputs output special values that enable a general fault warning in the higher-level control system. The values correspond to the "Namur" industry standard.

<table>
<thead>
<tr>
<th>Status message in the display</th>
<th>Class</th>
<th>Display value in the display</th>
<th>Analog output</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 to 20 mA</td>
</tr>
<tr>
<td>Watchdog error</td>
<td>Error</td>
<td>Previous value stops</td>
<td>21 mA</td>
</tr>
<tr>
<td>Value below min. scale</td>
<td>Underrange</td>
<td>Reading</td>
<td>0 mA</td>
</tr>
<tr>
<td>Value above max. scale</td>
<td>Overrange</td>
<td>Reading</td>
<td>20.5 mA</td>
</tr>
</tbody>
</table>
### 4.6. Maintenance and cleaning

#### 4.6.1. Maintaining the instrument

We recommend that the adjustment and settings of the transmitter be checked at regular intervals using the

- User menu (Operation, page 32) or
- P2A software (Parameterizing, adjusting and analyzing software (P2A software), page 53)

Convenient "remote monitoring" of the transmitter can be implemented, for example by using a relay as a collective alarm (see Editing Main Menu Alarm, page 39) whose messages are forwarded to a local alarm transmitter (horn, light) or PLC.

#### 4.6.2. Cleaning the instrument

- Only clean the instrument carefully with a moist cloth.
- Do not use aggressive cleaning agents.
- Do not use any solvents.

### 5 Parameterizing, adjusting and analyzing software (P2A software)

#### 5.1. Specifications

The P2A software is used for the parameterizing, adjustment and analysis of testo transmitters. The following applies:

- Generally, all newer testo transmitters (as of 2007) are supported.
- Included with every testo transmitter that is bought new is a CD that contains a free upgrade of the software, which includes the device drivers for all transmitters that can be attached at this time.
• This upgrade can be downloaded at any time via the testo homepage "www.testo.com/Download/P2A". The software must only be bought one time, even for owners of several testo transmitters.

5.1.1. Functions and use

In the P2A software, two different file types are used: The instrument and the parameter file.

Instrument file

The parameters of a particular transmitter are stored in its so-called instrument file. Using this file, the parameters can be edited and the instrument can be tested and adjusted.

Instrument files also contain the respective histories in addition to the parameter data, i.e. "log books" are kept for the previous parameterizations, adjustments and messages (see Transmitter history page 76).

Instrument files are ".cfm" format files.

Parameter file

Parameter files are not tied to a specific individual transmitter and contain only parameter data/no history data.

If you use various instruments of the same type, you can create parameter files once (e.g. by saving the appropriate instrument file as the parameter file) and transmit these onto the other instruments.

Parameter files are ".cfp" format files.

5.1.2. System requirements

Operating system
• Windows® 2000 SP4
• Windows® XP Home/Professional
• Windows® Vista

Computer
• Pentium processor of at least 400 MHz or equivalent
• 128 MB RAM
• Graphics resolution of at least 1024 x 768
• Unused hard drive capacity of at least 15 MB
• CD-ROM drive
• USB interface
• At least Internet Explorer 5.0.

Software

The P2A software must be purchased and installed separately from the transmitter. If it is a new software version, the transmitter is already supported completely. Older P2A software versions can be updated via the P2A software upgrade (cf. product CD included with the transmitter).

5.1.3. Scope of delivery

Included in the scope of delivery are:

• P2A software
• USB driver

When working with the parameterizing, adjusting and analyzing software (P2A software), previous knowledge of Windows® operating systems is assumed. The description in this instruction manual relates to Windows® XP.

5.2. First steps

5.2.1. Installing the software/driver

Administrator rights are required to install programs and drivers under Windows® 2000 SP4, XP and Vista.

5.2.1.1. Installing P2A software

1. Insert CD with P2A software.

✔ If the installation program does not start automatically:

   > Open Windows Explorer and start the file Setup.exe on the product CD.

2. Follow the directions of the installation wizard.

5.2.1.2. Installing USB driver

Before installing the USB driver, please read the separate documentation that is enclosed with the USB driver CD.
5.2.1.3. **P2A software upgrade**

1. Insert product CD (supplied with the transmitter).
2. Open Windows® Explorer and start the file **P2A upgrade.exe** on the product CD.
3. Follow the directions of the installation wizard.

5.2.2. **Starting the software**

5.2.2.1. **Starting the program**

> Select: [Start] > All Programs > Testo > P2A Software.
- The program window is opened (see User interface page 57).

5.2.2.2. **Establishing a connection with the instrument**

Multiple instruments can be attached, however only one connection is active at all times.

 ✓ USB driver is installed (see Installing USB driver page 55).

1. Start the P2A software.
2. Connect adapter (supplied with the P2A software) to the service interface of the instrument (see Service interface page 15).
3. Connect instrument/adapter to the PC via the USB interface.
- The instrument file of the attached instrument is shown in the file list.

5.2.2.3. **Activating the connection with the instrument**

> Click on the desired instrument file.
- The selected file is marked in colour and the connection with the instrument is activated.

If a connection with the instrument is established when the program is started, the corresponding instrument file is marked automatically.
5.3. Using the software

5.3.1. User interface

1. **Menu bar:**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Open</td>
<td>Shows the Windows dialogue for searching and opening files.</td>
</tr>
<tr>
<td></td>
<td>Save as</td>
<td>Saves the parameters of an instrument or parameter file under a new name.</td>
</tr>
<tr>
<td>Edit</td>
<td>Copy</td>
<td>Copies the parameters of the marked instrument or parameter file in the cache.</td>
</tr>
<tr>
<td></td>
<td>Paste</td>
<td>Pastes the parameters from the cache in the marked instrument or parameter file.</td>
</tr>
<tr>
<td>View</td>
<td>Toolbar</td>
<td>Activates/deactivates the toolbar or status bar.</td>
</tr>
<tr>
<td></td>
<td>Status bar</td>
<td></td>
</tr>
</tbody>
</table>
Menu | Command | Explanation
--- | --- | ---
? | Check instrument connections | Checks the connections to a connected instrument without the instrument having to be activated.
Service | | A text file with the most important information on the computer and the software is opened via Display service data.
Information | | Shows the version number of the P2A software.

2 Toolbar: Shows the Windows-compliant icons for editing.

3 File:

<table>
<thead>
<tr>
<th>Icon</th>
<th>File</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| ![Symbol](image1) Symbol shows a transmitter | Instrument file | Instrument file
Connection to the instrument has been established.
`<Type> <Serial number>.cfm`
File name should not be changed. |
| ![Symbol](image2) Symbol shows a transmitter with a red minus sign in the upper left corner | Instrument file | Instrument file
Connection to the instrument has not been established. |
| ![Symbol](image3) Symbol shows a transmitter with a white P for parameter file in the upper left corner | Parameter file | `<Type> <Serial number>
<Date> <Time>.cfp`
File name can be changed. The name can be selected freely, but it is recommended that you retain the reference to the instrument.
Parameter files are always marked red; the parameter values they contain are only forwarded to the instrument after being transmitted to the instrument file. |
4 Function buttons: Dialogues on editing and testing the instrument are opened by means of the buttons.

[Change parameterization] see Changing instrument/parameter file page 59

[Test/analyze transmitter] see Chapter Analyzing/testing the transmitter page 69

[Adjusting the transmitter] see Chapter Adjusting the transmitter page 74

[Transmitter history] see Transmitter history page 76

5 File information:

<table>
<thead>
<tr>
<th>Status</th>
<th>Shown in the window</th>
</tr>
</thead>
<tbody>
<tr>
<td>An instrument file is selected</td>
<td>Type, serial number, firmware version of the instrument.</td>
</tr>
<tr>
<td>A parameter file is selected</td>
<td>Type, serial number and firmware version of instrument for which the parameter file was created.</td>
</tr>
<tr>
<td>Connection status</td>
<td>Green = connection is active</td>
</tr>
<tr>
<td></td>
<td>Red = connection is inactive</td>
</tr>
</tbody>
</table>

6 Status bar: Shows the current status when editing via the menu bar.

5.3.2. Editing instrument/parameter file

5.3.2.1. Changing instrument/parameter file

✓ The desired instrument/parameter file is marked.

1. Click on [Change parameterization].

   - The Properties of <Instrument type> <Serial number> dialogue is opened with the Change parameterization register.

   If the parameters were transmitted from other parameter files into the instrument file, a message is shown with which you can transmit the new parameters to the connected instrument using [Yes].

   > If the parameters should not be transmitted, click on [No].

2. Change or enter parameters in the corresponding fields.
### Field | Explanation
--- | ---
Unit/Analog output | All analog outputs are parameterized in this mask.

**Unit/analog output (graphic)**

Unit: 0 to 1 V/5 V/10 V or 0 to 20 mA/4 to 20 mA.

Vertical: Current version of the analog output (cannot be changed).

Horizontal: Min./max. scale end points of selected unit.

The curve changes in accordance with the entered value of scale minimum and maximum.

**Scale minimum/maximunm**

The endpoints of the scaling can be selected up to the stored scale minimum and maximum. In the process, scaling can take place beyond the measuring range in order to adjust the analog output to the customer system, see Scaling, page 16.
### Field | Explanation
--- | ---
Unit | Selection of the physical unit. When changing the unit, standard values are set for scale minimum and maximum. **Caution!** When changing the phys. unit, the relay limit values are set to the assigned default values.
Signal delay (graphic) | Curve changes according to the set signal delay.
Signal delay | Time interval in stages 1 – 15:  
1 = no delay  
15 = longest delay.  
The signal delay is added to the reaction time of the sensor. The signal delay shows averaging over the time interval of the selected stage in seconds:  
Example  
Stage 10 = average of the readings from the last 10 seconds.
Limit values, relay 1 to 4/alarm values, alarm 1 to 4 | In this mask, the relays or display alarms are parameterized.
### Field | Explanation
--- | ---
Relay x/alarm x | Four relays or alarm values are available (optional).
Not used | Relay is not used. Hysteresis image and input options are hidden.
Collective alarm | A relay can be used as a collective alarm detector in the event that selected messages appear. Selection of the messages (OR linkage) by selecting the checkbox.
Min control | If switched to ON (NO contact) or OFF (NC contact) under the limit value; in the event of a subsequent exceeding of **Limit value** plus **Hysteresis**, it is switched to OFF (NO contact) or ON (NC contact).
### Field | Explanation
---|---
Max control | If switched to ON (NO contact) or OFF (NC contact) above the limit value; in the event of a subsequent undershooting of **Limit value** minus **Hysteresis**, it is switched to OFF (NO contact) or ON (NC contact).

---

The graphic display in the centre of the screen refers to the relay wiring as a NO contact (ON).

### Hysteresis | To avoid switching cycles.

### Channel | Selection of the channel that is to be monitored.

### Limit value | Values for the limits of the unit selected in **Unit/analog output**; 4 decimal places.
- When changing the phys. unit, the relay limit values are set to the default values.

### Visual alarm display | Checkbox is activated: Upon the appearance of the selected alarm, the background lighting of the display flashes.
<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm delay</td>
<td>The desired alarm delay for the alarms of the min/max control and the visual alarm is entered in the input field (0 to 240 seconds possible). The alarm delay has no effect on the collective alarms.</td>
</tr>
</tbody>
</table>

### Field: Basic settings

**Setting the pressure process data for Pitot tube measurement and standard data for volumetric flow rate measurement.**

![Image of software interface](image_url)

### Absolute pressure

Absolute pressure existing in the process. The entered absolute pressure value is included in the Pitot tube calculation.

### Temperature

Temperature existing in the process. The entered temperature value is included in the Pitot tube calculation.

### Humidity

Humidity existing in the process. The entered humidity value is included in the Pitot tube calculation.
### Field | Explanation
---|---
Pitot tube factor | The Pitot tube correction factor depends on the shape of the Pitot tube (see operating instructions of the Pitot tube).
The entered correction factor has a direct proportional effect on the volumetric flow rate.

Cross-section of the duct | The entered value is included in the Pitot tube calculation.

Correction factor | The correction factor enables an adjustment to the flow profile in the duct.
The entered correction factor is included in the Pitot tube calculation.

**Absolute pressure** | The entered value and the selected unit are included in the calculation of the standard volumetric flow rate.

**Temperature** | The entered value and the selected unit are included in the calculation of the standard volumetric flow rate.

**[Reset]** | Button for resetting the standard data to the factory settings.
<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Setting the display functions (if a display is available on the transmitter).</td>
</tr>
<tr>
<td>Continuous display lighting</td>
<td>Display lighting is permanently switched on.</td>
</tr>
<tr>
<td>Display lighting when button is pressed (10 seconds)</td>
<td>When a particular button on the instrument is pressed, the display lights up for 10 seconds.</td>
</tr>
<tr>
<td>Display brightness (0 to 9)</td>
<td>Setting the brightness between 0 and 9: 0 = dark 9 = light</td>
</tr>
<tr>
<td>Display contrast (0 to 9)</td>
<td>Setting the contrast between 0 and 9: 0 = low contrast 9 = high contrast</td>
</tr>
<tr>
<td>Display of the error messages</td>
<td>Selection of whether the error messages should be shown in the display.</td>
</tr>
<tr>
<td>Display language</td>
<td>Selection of the language.</td>
</tr>
<tr>
<td>New password</td>
<td>The password consists of four numbers, each of which must be between 1 and 9.</td>
</tr>
<tr>
<td></td>
<td>If the password protection is not to be used, the numerical code &quot;0000&quot; must be entered.</td>
</tr>
</tbody>
</table>
5 Parameterizing, adjusting and analyzing software (P2A software)

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Adopt new password]</td>
<td>Button for confirming the new password.</td>
</tr>
<tr>
<td>Valid password</td>
<td>Display of the current password.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zeroing cycle</td>
<td>Setting the interval of the automatic zeroing with solenoid valve.</td>
</tr>
</tbody>
</table>

The accuracy specifications are only valid for the zeroing cycle of 15 sec set by the factory.

Zeroing cycle setting | Selection of the time interval after which the automatic zeroing cycle is to occur. Recommendation: 15 sec

5.3.2.2. Saving parameters

Parameters can be saved in new parameter files.

1. Mark instrument/parameter file.
2. Click on File > Save as in the menu bar.
3. Select storage location and enter the file name.
4. Click on [Save].
   - The new parameter file is shown in the file list.
Only the parameters are saved from an instrument file; the history data are not adopted.

The original name (Instrument type, Serial number) is suggested with the current date/time as standard, e.g. "testo 6381 01234578 061120 1403.cfp".

For a standard installation, the files are saved under "C:\Documents and Settings\All Users\Shared Documents\P2A Software". The path can differ depending on the version of the operating system.

5.3.2.3. Opening the parameter file

All parameter files stored in the standard directory path are automatically displayed in the file list when the software is started.

You can also open parameter files that are stored in other directories.

1. Click on File > Open in the menu bar.
2. Select the storage location and click on the requisite file.
3. Click on [Open].
   - The selected file is opened. This can be changed and saved (see Editing instrument/parameter file page 59).

5.3.2.4. Copying and pasting parameters

The parameters of a parameter file can be transmitted to an instrument file or another parameter file from the same instrument type.

1. Select file from which parameters are to be copied.
2. Click on Edit > Copy in the menu bar.
3. Select the file which is to be modified.
4. Click on Edit > Paste in the menu bar.
   - The parameters are transmitted to the file.

You can also use the common keyboard shortcuts for copying (CTRL+C) and pasting (CTRL+V).

Parameters can also be transmitted using drag & drop, where you drag the icon of the parameter file onto the icon of the target instrument file.

5. Connect and select corresponding instrument.
6. Click on [Change parameterization].
7. Confirm confirmation request.
Parameter data are transferred to the instrument.

5.3.2.5. Deleting instrument/parameter file
Instrument/parameter files can be deleted from the file list.
1. Click on the file that is to be deleted with the right mouse button.
2. Select the command **Delete** in the context menu.
- The instrument or parameter file is deleted from the list.

5.3.2.6. Creating a new instrument file
It is possible to create an instrument file without restarting the P2A software.
- Transmitter must be connected.
1. Click on **File > New connection** in the menu bar.
- Connection to the transmitter is established.

5.3.3. Analyzing/testing the transmitter
In this section, you can test the outputs of the connected instrument, read off the limit values and reset the parameters to the factory settings.
The function is only available for instrument files.

5.3.3.1. Analyzing/testing the instrument
- The required instrument file is marked.
1. Click on **[Test/analyze transmitter]**.
- The **Properties of <Instrument type> <Serial number>** dialogue is opened with the **Test/analyze transmitter** register.
2. Perform action:

<table>
<thead>
<tr>
<th>Action</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carrying out factory reset</td>
<td>Reset the unit, limit value and hysteresis parameters to factory settings (see below).</td>
</tr>
<tr>
<td>Testing analog output</td>
<td>Test channel 1 (see Testing functionality of analog outputs, page 43).</td>
</tr>
<tr>
<td>Test switch outputs</td>
<td>Manually switch relays 1 to 4 to test for proper function (see Testing functionality of relay outputs, page 44).</td>
</tr>
</tbody>
</table>
5 Parameterizing, adjusting and analyzing software (P2A software)

<table>
<thead>
<tr>
<th>Action</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display min./max. values</td>
<td>Overview of the minimum and maximum values measured since the last reset of the transmitter (see Displaying min./max. values, page 73).</td>
</tr>
</tbody>
</table>

3. Click on [OK] or [Cancel] to close the dialogue.

5.3.3.2. Carrying out factory reset

✓ The required instrument file is marked.

1. Click on [Test/analyze transmitter].
   - The Properties of <Instrument type> <Serial number> dialogue is opened with the Test/analyze transmitter register.

2. Mark transmitter test.
   - Current operating hours are shown.

3. Confirm control query to perform the reset.
   - The values are reset to the customer-specific factory settings.

4. Click on [OK] or [Cancel] to close the dialogue.

5.3.3.3. Testing analog output

✓ The required instrument file is marked.

1. Click on [Test/analyze transmitter].
   - The Properties of <Instrument type> <Serial number> dialogue is opened with the Test/analyze transmitter register.

2. Mark channel and test values.

<table>
<thead>
<tr>
<th>Field/button</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmitter test</td>
<td>Check the analog outputs (see Testing functionality of analog outputs, page 43).</td>
</tr>
</tbody>
</table>
## Field/button | Explanation
---|---
Current reading | Readings are updated every second.
Unit | Unit according to the type of analog output.
Default value | Freely definable output value for the respective type of analog output (V or mA), 1 decimal place.
[Activate] | The entered default value is forwarded to the corresponding analog output and to the test contacts by clicking.
A warning informs that the value is being transmitted to the connected instrument in the event of existing cabling.
Now check the analog output using a precise multimeter.
[Deactivate] | Finish entering the electrical variables at the analog output.
The analog output returns to the current reading again.

3. Click on [OK] or [Cancel] to close the dialogue.
   - The analog output and the relay return to Measuring Mode again.
5.3.3.4. **Testing switch output relays 1 to 4**

✓ The required instrument file is marked.

1. Click on [Test/analyze transmitter].
   - The Properties of <Instrument type> <Serial number> dialogue is opened with the Test/analyze transmitter register.

2. Mark **Relay tests** and test the values.

<table>
<thead>
<tr>
<th>Field/button</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Activate relay n</strong></td>
<td>Close contact.</td>
</tr>
<tr>
<td></td>
<td>A warning informs that the value is being transmitted to a connected PLC, external display, etc. in the event of existing cabling.</td>
</tr>
<tr>
<td><strong>Deactivate relay n</strong></td>
<td>Open contact.</td>
</tr>
<tr>
<td></td>
<td>A warning informs that the value is being transmitted to a connected PLC, external display, etc. in the event of existing cabling.</td>
</tr>
</tbody>
</table>

3. Click on [OK] or [Cancel] to close the dialogue.
   - The analog output returns to Measuring Mode again.
5.3.3.5. Displaying min./max. values

The transmitter saves the minimum or maximum value for each channel (measured since the last voltage supply or since the last manual reset).

✓ The required instrument file is marked.

1. Click on [Test/analyze transmitter].
   - The Properties of <Instrument type> <Serial number> dialogue is opened with the Test/analyze transmitter register.

2. Mark Min./max. values.

<table>
<thead>
<tr>
<th>Field/button</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min./max. values</td>
<td>View the min./max. values of each channel. Only the values within the measuring range are shown.</td>
</tr>
</tbody>
</table>

Field/button Explaination

Min./max. values View the min./max. values of each channel. Only the values within the measuring range are shown.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Channel 1 min./max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Min. or max. value, 1 decimal place.</td>
</tr>
<tr>
<td>Unit</td>
<td>Unit selected in Unit/analog output.</td>
</tr>
</tbody>
</table>

3. Reset Min./max. values.
4. Click on [Reset min./max. values].
5. Confirm control query to perform the reset.
   - The values are reset to the factory settings.
6. Click on [OK] or [Cancel] to close the dialogue.

5.3.4. **Adjusting the transmitter**

This function is used to adjust an attached instrument. The following adjustments may be carried out using the software:

- Analog adjustment (entry via assistant/wizard)
- n-point adjustment (entry via assistant/wizard)

Also see Editing Main Menu Adjust, page 47

5.3.4.1. **n-point adjustment**

1. Connect precision pressure sensor (see n-point adjustment, page 31).
2. Mark the instrument file of the connected instrument.
3. Click on [Adjusting the transmitter].
   - The Properties of <Instrument type> <Serial number> dialogue is opened with the Adjusting the transmitter register.
4. Mark n-point adjustment.
5. Click on [Start wizard …] and follow the instructions of the wizard.
   - The adjustment is performed when the wizard is closed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustment curve</td>
<td><img src="image" alt="Adjustment curve" /></td>
</tr>
<tr>
<td>Adjustment point 1</td>
<td><img src="image" alt="Adjustment point 1" /></td>
</tr>
<tr>
<td>which value is preset by a pressure sensor:</td>
<td>1 Pa</td>
</tr>
</tbody>
</table>
5 Parameterizing, adjusting and analyzing software (P2A software)

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>How much pressure is actually applied</td>
<td>Required field: Entry of the value read off at the pressure sensor.</td>
</tr>
</tbody>
</table>

The n-point adjustment must always be carried out to its full extent and in good time at all selected adjustment points.

The number of adjustment points (3 to 6) is stored in the user menu of the transmitter and can only be changed via the P2A software.

5.3.4.2. Adjusting the analog output

1. Connect precision multimeter (see Analog output adjustment, page 30).
2. Mark the instrument file of the connected instrument.
3. Click on [Adjusting the transmitter].
   - The Properties of <Instrument type> <Serial number> dialogue is opened with the Adjusting the transmitter register.
4. Click on [Start wizard …] and follow the instructions of the wizard.
   - The adjustment is performed when the wizard is closed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Explanation</td>
</tr>
</tbody>
</table>

![Analog outputs adjustment](image)

Note

Channel 1

Lower analog adjustment point

0.367

Measured analog value (precise multimeter required):

Entry imperative!
5 Parameterizing, adjusting and analyzing software (P2A software)

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default value</td>
<td>The analog output value from the last performed adjustment is given at the output. Value of the factory adjustment:</td>
</tr>
<tr>
<td></td>
<td>• Lower adjustment point: approx. 10 % of the max. value</td>
</tr>
<tr>
<td></td>
<td>• Centre adjustment point: approx. 50 % of the max. value</td>
</tr>
<tr>
<td></td>
<td>• Upper adjustment point: approx. 90 % of the max. value</td>
</tr>
<tr>
<td>Measured analog</td>
<td>Required field: Entry of the value read off at the multimeter.</td>
</tr>
<tr>
<td>value</td>
<td></td>
</tr>
</tbody>
</table>

5.3.5. **Transmitter history**

Parameterizations, adjustment processes and messages that have occurred are registered in the transmitter with an operating hours stamp.

In the history overviews (explained later in more detail), past processes and events can be made visible.

- For parameter changes or adjustments that are performed directly at the instrument (via the user menu), "Transmitter" is entered in the **User** field and only the operating hour is entered in the **Date/time** field instead of operating hour/date/time.

- For entries that are performed using the P2A software, the name of the user logged into Windows appears in the **User** field, while the date/time and operating hour are shown in the **Date/time** field.

1. Mark the instrument file of the connected instrument.
2. Click on the [Transmitter history] button.
3. The **Properties of <Instrument type> <Serial number>** dialogue is opened with the **Transmitter history** register.
4. Click on the required entry in the list to change the display.
### 5 Parameterizing, adjusting and analyzing software (P2A software)

#### Field | Explanation
--- | ---
Operating hours / date/time | Operating hour/time stamp at which the change at the instrument was performed.
User | Name with which the user is logged into the operating system.
"Transmitter" entry if the change was performed at the instrument.
Comments | Type of parameter change, e.g. "Unit of channel 1 from Pa to bar".
5 Parameterizing, adjusting and analyzing software (P2A software)

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating hours / date/time</td>
<td>Operating hour/time stamp at which the change at the instrument was performed.</td>
</tr>
<tr>
<td>User</td>
<td>Name with which the user is logged into the operating system. &quot;Transmitter&quot; entry if the change was performed at the instrument.</td>
</tr>
<tr>
<td>Unit</td>
<td>Unit during the adjustment.</td>
</tr>
<tr>
<td>Channel</td>
<td>Analog adjustment: Channel 1 to n.</td>
</tr>
<tr>
<td>Specification</td>
<td>Analog adjustment: Actual value.</td>
</tr>
<tr>
<td>Pressure specification</td>
<td>n-point adjustment: Reference value set at the pressure sensor.</td>
</tr>
<tr>
<td>Multimeter</td>
<td>Analog adjustment: Reference value set at the multimeter.</td>
</tr>
<tr>
<td>Offset</td>
<td>Analog adjustment: Deviation at time of adjustment.</td>
</tr>
</tbody>
</table>
The table is shown only for error and status messages that were generated in the transmitter and were transferred and saved there via the connection to the P2A software.

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating hour</td>
<td>Operating hour at which the message appeared in the instrument.</td>
</tr>
<tr>
<td>Message</td>
<td>e.g. &quot;Watchdog error&quot;. Due to a processor error, the transmitter performs an automatic restart.</td>
</tr>
<tr>
<td>Type of message</td>
<td>e.g. early warning, status message.</td>
</tr>
</tbody>
</table>

> To print out the history data, click on [Print].

The printing job is automatically sent to the default printer for the operating system.

The printout can be edited using [Set up printer ...].

4. Click on [OK] or [Cancel] to close the dialogue.
6 Tips and assistance

6.1. Questions and answers

<table>
<thead>
<tr>
<th>Question</th>
<th>Possible causes/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection to instrument cannot be established</td>
<td>Check connection cable/plug contacts</td>
</tr>
<tr>
<td>A message appears on the display</td>
<td>See Status, warning and error messages, page 48</td>
</tr>
<tr>
<td>Malfunction (with and without display)</td>
<td>Analysis using the P2A software, see Analyzing/testing the transmitter, page 69</td>
</tr>
<tr>
<td>When does a stable current reading appear?</td>
<td>After approx. 20 seconds</td>
</tr>
</tbody>
</table>

If we could not answer your question, please contact your dealer or Testo Customer Service. For contact details see the rear side of this document or the web page www.testo.com/service-contact

6.2. Accessories and spare parts

<table>
<thead>
<tr>
<th>Description</th>
<th>Article no.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ethernet</strong></td>
<td></td>
</tr>
<tr>
<td>Ethernet module</td>
<td>0554 6656</td>
</tr>
<tr>
<td>Ethernet connector</td>
<td>0554 6653</td>
</tr>
<tr>
<td><strong>Interface and software</strong></td>
<td></td>
</tr>
<tr>
<td>P2A software (parameterizing, adjusting, analyzing) incl. USB adapter</td>
<td>0554 6020</td>
</tr>
<tr>
<td><strong>Plug-in connections</strong></td>
<td></td>
</tr>
<tr>
<td>Set of M12 plug-in connections (connector and socket) for power and signal lines</td>
<td>0554 6682</td>
</tr>
<tr>
<td><strong>Hoses</strong></td>
<td></td>
</tr>
<tr>
<td>Silicone hose ID 4 transparent</td>
<td>0086 0001, sold by the metre</td>
</tr>
<tr>
<td>TYGON hose ID 4.8 transparent</td>
<td>0086 0031, sold by the metre</td>
</tr>
</tbody>
</table>
### Description

<table>
<thead>
<tr>
<th>Description</th>
<th>Article no.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pitot tubes</strong></td>
<td></td>
</tr>
<tr>
<td>Pitot tube, length 350 mm, stainless steel</td>
<td>0635 2145</td>
</tr>
<tr>
<td>Pitot tube, length 1000 mm, stainless steel</td>
<td>0635 2345</td>
</tr>
<tr>
<td><strong>Supply</strong></td>
<td></td>
</tr>
<tr>
<td>Mains unit (desktop, wall-mounted)</td>
<td>0554 1748</td>
</tr>
<tr>
<td>Mains unit (top-hat rail mounting)</td>
<td>0554 1749</td>
</tr>
<tr>
<td><strong>External display</strong></td>
<td></td>
</tr>
<tr>
<td>Process display for testo 54-2 AC....</td>
<td>5400 7553</td>
</tr>
<tr>
<td>Process display for testo 54-7 AC....</td>
<td>5400 7555</td>
</tr>
<tr>
<td>** Calibration**</td>
<td></td>
</tr>
<tr>
<td>Standard ISO calibration certificate, transmitter only</td>
<td>0520 1000</td>
</tr>
<tr>
<td>Standard DKD calibration certificate, transmitter only</td>
<td>0520 1200</td>
</tr>
</tbody>
</table>

For a complete list of all accessories and spare parts, please refer to the product catalogues and brochures or look up our website at: [www.testo.com](http://www.testo.com)

### 6.2.1. Ordering options for 6381 transmitter (0555 6381)

<table>
<thead>
<tr>
<th>Order code</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Axx Measuring range</strong></td>
<td></td>
</tr>
<tr>
<td>A01</td>
<td>0 to 50 Pa</td>
</tr>
<tr>
<td>A02</td>
<td>0 to 50 Pa</td>
</tr>
<tr>
<td>A03</td>
<td>0 to 100 Pa</td>
</tr>
<tr>
<td>A04</td>
<td>0 to 500 Pa</td>
</tr>
<tr>
<td>A05</td>
<td>0 to 10 hPa</td>
</tr>
<tr>
<td>A07</td>
<td>0 to 50 hPa</td>
</tr>
<tr>
<td>A08</td>
<td>0 to 100 hPa</td>
</tr>
<tr>
<td>A09</td>
<td>0 to 500 hPa</td>
</tr>
<tr>
<td>A10</td>
<td>0 to 1000 hPa</td>
</tr>
<tr>
<td>A21</td>
<td>-10 to 10 Pa</td>
</tr>
<tr>
<td>A22</td>
<td>-50 to 50 Pa</td>
</tr>
</tbody>
</table>
## Order code vs. Characteristic

<table>
<thead>
<tr>
<th>Order code</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td>A23</td>
<td>-100 to 100 Pa</td>
</tr>
<tr>
<td>A24</td>
<td>-500 to 500 Pa</td>
</tr>
<tr>
<td>A25</td>
<td>-10 to 10 hPa</td>
</tr>
<tr>
<td>A27</td>
<td>-50 to 50 hPa</td>
</tr>
<tr>
<td>A28</td>
<td>-100 to 100 hPa</td>
</tr>
<tr>
<td>A29</td>
<td>-500 to 500 hPa</td>
</tr>
<tr>
<td>A30</td>
<td>-1000 to 1000 hPa</td>
</tr>
</tbody>
</table>

### Bxx Analog output/supply

<table>
<thead>
<tr>
<th>Bxx</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B02</td>
<td>0 to 1 V (4-wire, 24 V AC/DC)</td>
</tr>
<tr>
<td>B03</td>
<td>0 to 5 V (4-wire, 24 V AC/DC)</td>
</tr>
<tr>
<td>B04</td>
<td>0 to 10 V (4-wire, 24 V AC/DC)</td>
</tr>
<tr>
<td>B05</td>
<td>0 to 20 mA (4-wire, 24 V AC/DC)</td>
</tr>
<tr>
<td>B06</td>
<td>4 to 20 mA (4-wire, 24 V AC/DC)</td>
</tr>
</tbody>
</table>

### Cxx Display

<table>
<thead>
<tr>
<th>Cxx</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C00</td>
<td>Without display</td>
</tr>
<tr>
<td>C02</td>
<td>With display/English</td>
</tr>
<tr>
<td>C03</td>
<td>With display/German</td>
</tr>
<tr>
<td>C04</td>
<td>With display/French</td>
</tr>
<tr>
<td>C05</td>
<td>With display/Spanish</td>
</tr>
<tr>
<td>C06</td>
<td>With display/Italian</td>
</tr>
<tr>
<td>C07</td>
<td>With display/Japanese</td>
</tr>
<tr>
<td>C08</td>
<td>With display/Swedish</td>
</tr>
</tbody>
</table>

### Dxx Cable entry

<table>
<thead>
<tr>
<th>Dxx</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D01</td>
<td>M16 cable entry (relay: M20)</td>
</tr>
<tr>
<td>D02</td>
<td>Cable entry NPT 1/2&quot;</td>
</tr>
<tr>
<td>D03</td>
<td>Cable contacting via M plug-in connection for signal and supply</td>
</tr>
</tbody>
</table>

### Exx Ethernet

<table>
<thead>
<tr>
<th>Exx</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E00</td>
<td>Without Ethernet module</td>
</tr>
<tr>
<td>Order code</td>
<td>Characteristic</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>E01</td>
<td>With Ethernet module</td>
</tr>
<tr>
<td><strong>Fxx Differential pressure unit</strong>⁸</td>
<td></td>
</tr>
<tr>
<td>F01</td>
<td>Pa/Min/Max</td>
</tr>
<tr>
<td>F02</td>
<td>hPa/Min/Max</td>
</tr>
<tr>
<td>F03</td>
<td>kPa/Min/Max</td>
</tr>
<tr>
<td>F04</td>
<td>mbar/Min/Max</td>
</tr>
<tr>
<td>F05</td>
<td>bar/Min/Max</td>
</tr>
<tr>
<td>F06</td>
<td>mmH₂O /Min/Max</td>
</tr>
<tr>
<td>F07</td>
<td>inchH₂O /Min/Max</td>
</tr>
<tr>
<td>F08</td>
<td>inch HG/Min/Max</td>
</tr>
<tr>
<td>F09</td>
<td>kg/cm² /Min/Max</td>
</tr>
<tr>
<td>F10</td>
<td>PSI/Min/Max</td>
</tr>
<tr>
<td>F11</td>
<td>m/s /Min/Max</td>
</tr>
<tr>
<td>F12</td>
<td>ft/min /Min/Max</td>
</tr>
<tr>
<td>F13</td>
<td>m³/h /Min/Max</td>
</tr>
<tr>
<td>F14</td>
<td>l/min /Min/Max</td>
</tr>
<tr>
<td>F15</td>
<td>Nm³/min /Min/Max</td>
</tr>
<tr>
<td>F16</td>
<td>Nl/min /Min/Max</td>
</tr>
<tr>
<td><strong>Gxx Optional analog output for humidity probe connection testo 6610/units</strong></td>
<td></td>
</tr>
<tr>
<td>G00</td>
<td>Without connection option for testo 6610 humidity probe</td>
</tr>
<tr>
<td>G01</td>
<td>% RH/Min/Max</td>
</tr>
<tr>
<td>G02</td>
<td>°C/Min/Max</td>
</tr>
<tr>
<td>G03</td>
<td>°F/Min/Max</td>
</tr>
<tr>
<td>G04</td>
<td>°C₉₀/Min/Max</td>
</tr>
<tr>
<td>G05</td>
<td>°F₉₀/Min/Max</td>
</tr>
<tr>
<td>G06</td>
<td>g/kg /Min/Max</td>
</tr>
</tbody>
</table>

⁸ Scaling 10 to 100 % of measuring range is possible, but at least 10 Pa
<table>
<thead>
<tr>
<th>Order code</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td>G07</td>
<td>gr/lb /Min/Max</td>
</tr>
<tr>
<td>G08</td>
<td>g/m³ /Min/Max</td>
</tr>
<tr>
<td>G09</td>
<td>gr/ft³ /Min/Max</td>
</tr>
<tr>
<td>G10</td>
<td>ppm (vol)/Min/Max</td>
</tr>
<tr>
<td>G11</td>
<td>°Cwb/Min/Max</td>
</tr>
<tr>
<td>G12</td>
<td>°Fwb/Min/Max</td>
</tr>
<tr>
<td>G13</td>
<td>kJ/kg /Min/Max (enthalpy)</td>
</tr>
<tr>
<td>G14</td>
<td>mbar/Min/Max (water vapour partial pressure)</td>
</tr>
<tr>
<td>G15</td>
<td>inch H₂O/Min/Max (water vapour partial pressure)</td>
</tr>
<tr>
<td>G16</td>
<td>°Ctm</td>
</tr>
<tr>
<td>G17</td>
<td>°Ftm</td>
</tr>
</tbody>
</table>

**Hxx Relay**

<table>
<thead>
<tr>
<th>H00</th>
<th>Without relay</th>
</tr>
</thead>
<tbody>
<tr>
<td>H01</td>
<td>4 relay outputs, limit value monitoring</td>
</tr>
<tr>
<td>H02</td>
<td>4 relay outputs, channel 1 limit values and collective alarm</td>
</tr>
</tbody>
</table>

**Ixx Units, channel 3 (only if optional humidity probe connection is available)**

<table>
<thead>
<tr>
<th>I00</th>
<th>Without testo 6610 humidity probe</th>
</tr>
</thead>
<tbody>
<tr>
<td>I01</td>
<td>% RH/Min/Max</td>
</tr>
<tr>
<td>I02</td>
<td>°C/Min/Max</td>
</tr>
<tr>
<td>I03</td>
<td>°F/Min/Max</td>
</tr>
<tr>
<td>I04</td>
<td>°Ctd/Min/Max</td>
</tr>
<tr>
<td>I05</td>
<td>°Ftd/Min/Max</td>
</tr>
<tr>
<td>I06</td>
<td>g/kg /Min/Max</td>
</tr>
<tr>
<td>I07</td>
<td>gr/lb /Min/Max</td>
</tr>
<tr>
<td>I08</td>
<td>g/m³ /Min/Max</td>
</tr>
</tbody>
</table>

---

9 Only possible if G code (as of G01) was selected
<table>
<thead>
<tr>
<th>Order code</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td>I09</td>
<td>gr/ft³/Min/Max</td>
</tr>
<tr>
<td>I10</td>
<td>ppm (vol)/Min/Max</td>
</tr>
<tr>
<td>I11</td>
<td>ºC_{wb}/Min/Max</td>
</tr>
<tr>
<td>I12</td>
<td>ºF_{wb}/Min/Max</td>
</tr>
<tr>
<td>I13</td>
<td>kJ/kg/Min/Max (enthalpy)</td>
</tr>
<tr>
<td>I14</td>
<td>mbar/Min/Max (water vapour partial pressure)</td>
</tr>
<tr>
<td>I15</td>
<td>inch H₂O/Min/Max (water vapour partial pressure)</td>
</tr>
<tr>
<td>I16</td>
<td>ºC_{tm}</td>
</tr>
<tr>
<td>I17</td>
<td>ºF_{tm}</td>
</tr>
<tr>
<td>I18</td>
<td>% vol</td>
</tr>
</tbody>
</table>

**Kxx Languages of instruction manual**

| K01       | German/English instruction manual                 |
| K02       | French/English instruction manual                 |
| K03       | Spanish/English instruction manual                |
| K04       | Italian/English instruction manual                |
| K05       | Dutch/English instruction manual                  |
| K06       | Japanese/English instruction manual               |
| K07       | Chinese/English instruction manual                |
| K08       | Swedish/English instruction manual                |